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Customizing AutoCADChapter 1: 

The overall goal of customization is to tailor AutoCAD® to suit your specific needs. 
Customizations can range from the use of workspaces that quickly change the interface, to 
extensive custom applications that automate highly complex tasks. 

As your experience level increases, you can begin to explore the various areas of customization. 
Keep in mind, however, that customizing AutoCAD generally requires a solid understanding of 
the application and its commands. For this reason, customization is not recommended for new 
users. You should also keep in mind that some aspects of customization require practice and 
patience. When done correctly, the results will be gratifying and should lead to measurable 
increases in productivity.

Objectives

After completing this chapter, you will be able to:

■ Use workspaces to change interface configurations. 
■ Create and manage macros and keyboard shortcuts by using the Customize User Interface 

dialog box. 
■ Describe, create, and manage custom toolbars by using the Customize User Interface 

dialog box. 
■ Describe and create custom dashboard panels. 
■ Use double-click actions to customize the behavior of the software when specific types of 

objects are double-clicked. 
■ Create custom menus by using the Customize User Interface dialog box. 
■ Migrate customization files. 
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2  ■ Chapter 1:  Customizing AutoCAD

Lesson:  Using Workspaces

Overview

This lesson describes how to use workspaces to change interface configurations.

When working on a project, you may be required to perform many different tasks. Using workspaces, 
you can customize your interface to provide easier access to the tools required for each task. 

The following illustration represents a typical software interface.

Objectives

After completing this lesson, you will be able to:

■  Describe workspaces. 
■  Identify the different parts of the Workspace Settings dialog box. 
■  Identify the Workspace Contents pane in the Customize User Interface dialog box. 
■  Create and activate workspaces. 
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Lesson:  Using Workspaces ■ 3

About Workspaces

Workspaces help organize your drawing environment and enable you to be more productive in 
performing project tasks. 

Definition of Workspaces

Workspaces are groups of organized interface elements like the dashboard, menus, toolbars, and 
dockable windows that work in a custom, task-oriented drawing environment. Using workspaces, you 
can create and customize the interface to display only options that are relevant to your current tasks. 

The following illustration represents a typical interface with its elements.

 

  Toolbars   Dashboard

  Menus   Palettes (Dockable windows)
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4  ■ Chapter 1:  Customizing AutoCAD

Workspaces and Profiles

While the elements of both workspaces and profiles can change the display of your drawing 
environment, there are some key differences.

Workspaces control the display of menus, toolbars, and dockable windows in the drawing area. You 
can switch workspaces to change the display of your drawing area. You manage your workspaces in 
the Customize User Interface dialog box. Workspaces do not store system settings and other values 
that are set in the Options dialog box.

Different users and projects create different profiles. You can also share profiles by importing and 
exporting them as ARG files. Profiles collect and store many user options, drafting settings, paths, and 
values. Each time you make a change to one of these options, the profile updates. You can manage 
your profiles from the Options dialog box.

Workspaces Toolbar

In the workspace environment, you access the commands to create, edit, delete, and organize 
workspaces. You can access the workspace environment using the Workspaces toolbar, the command 
line, or menus.

Command Access

Example of a Workspace

AutoCAD can be used to create both two dimensional (2D) and three dimensional (3D) designs. 
Typically, when you are creating 2D designs, you have little use for solid modeling and surfacing tools. 
However, if you are required to do both 2D and 3D designs in your daily work, you create a workspace 
for both 2D and 3D design tasks. The 2D design workspace contains the standard 2D drafting and 
modification tools while the 3D design workspace contains all the solid modeling and surface 
modeling tools with the exception of dimensioning and annotation tools.

  
  

Toolbar:  Workspaces
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Lesson:  Using Workspaces ■ 5

This illustration shows how you can switch between 2D or 3D design tasks using the 
Workspaces toolbar.

Workspace Settings Dialog Box

The Workspace Settings dialog box allows you to control the order and appearance of workspaces in 
the Workspaces toolbar list and menu. 

Command Access

 

  

Workspace Settings

  

Command Line:  WSSETTINGS

Menu:  Tools > Workspaces > Workspace Settings

Toolbar:  Workspaces (List) > Workspace Settings

Toolbar:  Workspace Settings icon
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6  ■ Chapter 1:  Customizing AutoCAD

The Workspace Settings Dialog Box 

The following options are available in the Workspace Settings dialog box.

  When you click My Workspace, it gives you an option to assign one of the workspaces to the 
My Workspace icon.

  Under Menu Display and Order, click the check box for each workspace you want to display in 
the Workspaces toolbar list. The selected workspaces also display on the Tools > Workspaces 
menu. Unchecked workspaces do not appear in the toolbar list or the menu.

  Use the Move Up/Move Down buttons to move the selected workspace up or down in the 
Workspaces toolbar list and menu.

  Use the Add Separator button to add a separator line above the selected workspace.

  When you want to switch to a different workspace without saving changes you made to 
 workspace, select Do not save changes to workspace under the When Switching 
Workspaces area.

  In When Switching Workspaces, you can select Automatically save workspace changes option 
to save changes you make to a workspace when you switch to a different workspace.
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Lesson:  Using Workspaces ■ 7

The Customize User Interface Dialog Box

The Customize User Interface dialog box is a single, common utility for customizing the interface. 
It enables you to edit and organize the interface and create workspaces. 

Command Access

You can access the Customize User Interface dialog box by the following methods: 

Although you use the Customize User Interface dialog box to customize several aspects of the 
application, this section limits to its functionality relating to workspaces.

  

Customize User Interface

Command Line:  CUI

Menu:  Tools > Customize > Interface

Menu:  Tools > Workspaces > Customize

Toolbar:  Right-click any button > Customize

Toolbar:  Workspaces (List) > Customize

Dashboard:  Right-click any control panel > Customize
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8  ■ Chapter 1:  Customizing AutoCAD

Customize User Interface Dialog Box

The following options are available in the Customize User Interface dialog box.

 

  Customization elements appear in a tree view list under Customizations In All CUI Files 
pane. Workspaces, Toolbars, Menus, Dashboard Panels, Shortcut Menus, Double Click Actions, 
Keyboard Shortcuts, Mouse Buttons, LISP Files, Legacy, and Partial CUI Files are categories 
of elements.

  To view the content and its group of toolbars, menus, and dockable windows of a selected 
workspace, use the Workspace Contents pane. Expand each group to access elements in 
the group.

  Use the Properties pane to display the properties for the selected element.

  The Command List helps to list and use commands used in other panes of the dialog box.
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Lesson:  Using Workspaces ■ 9

Workspace Customization

You can customize workspaces in the Workspace Contents pane to make changes to the selected 
workgroup’s elements. New workspaces do not contain any toolbars or menus; however, you can add 
these elements. You can either select a group to add all of its elements or only certain elements you 
require in the workspace.

Creating and Activating Workspaces

When you install the software, it creates the AutoCAD Classic, 3D Modeling and 2D Drafting & 
Annotation workspaces. To make use of the workspace feature, you can modify the default workspace 
as well as create new workspaces as required.
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10  ■ Chapter 1:  Customizing AutoCAD

Procedure:  Creating Workspaces

The following steps describe how to create a new workspace.

1. On the Workspaces toolbar, select Customize from the list.

  

2. In the Customization User Interface pane, right-click Workspaces. 

■ Click New Workspace. 
■ Rename the new workspace.

  

3. In the Workspace Contents pane, click the Customize Workspace button.

  

Saving Toolbar Positions
To modify and save toolbar positions after creating a workspace, switch to a new workspace 
by selecting the Automatically save workspace changes option in the Workspace Settings 
dialog box. You can save the changes by clicking Save Current As in the Workspaces toolbar 
list and select the current workspace in the Save Workspace dialog box.
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Lesson:  Using Workspaces ■ 11

Procedure:  Activating Workspaces

The following steps describe how to activate and add toolbars to a new workspace.

1. In the Customizations In New CUI File pane, expand the toolbars: 

■ Expand menu groups and click elements to add to the workspace.
■ In the Workspace Contents pane, click Done.

  

2. Click OK to close the Customization User Interface pane.

3. On the Workspaces toolbar, select the new workspace from the list to activate it. You need to 
modify the initial toolbar placement.

  

Saving Toolbar Positions
To modify and save toolbar positions after creating a workspace, switch to a new workspace 
by selecting the Automatically save workspace changes option in the Workspace Settings 
dialog box. You can save the changes by clicking Save Current As in the Workspaces toolbar 
list and select the current workspace in the Save Workspace dialog box.

Sa
mp
le
 C
ha
pt
er

Autodesk® Intellectual Property

Not Valid for S
ale or R

esale



12  ■ Chapter 1:  Customizing AutoCAD

Exercise:  Create a Workspace for Visualization

In this exercise, you create a workspace tailored for visualizing and rendering 3D models.

You have just finished creating 3D Model of a home. Now, as you need to render it, you decide to create 
a workspace that contains all of the tools needed to complete the task. You begin with a blank workspace and 
add the toolbars and menus that are most frequently used for visualization.

You do the following:

■ Create a new workspace.
■ Activate the new workspace and customize it.

Create a New Workspace

The completed exercise 

Completing the Exercise
To complete the exercise, follow the 
steps in this book or in the onscreen 
exercise. In the onscreen list of chapters 
and exercises, click Chapter 1: 
Customizing AutoCAD. Click Exercise: 
Create a Workspace for Visualization.

1. Create a new drawing using your default 
template.
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Lesson:  Using Workspaces ■ 13

Customize and Activate Workspace

2. On the Workspaces toolbar, select 
Customize.

  

NOTE:  If the Workspaces toolbar is not 
displayed, right-click any toolbar. Click 
Workspaces.

3. In the Customize User Interface dialog box: 

■ Right-click the Workspaces group. 
■ Click New Workspace. 

  

■ For Name, enter Visualize.

1. In the Workspace Contents pane, click 
Customize Workspace.

  

2. In the Customizations In All CUI Files pane, 
select the Menus check box to add all drop-
down menus to the workspace.

  

3. In the Customizations In All CUI Files pane, 
expand the Toolbars group and select the 
check boxes for the following toolbars: 

■ Draw 
■ Inquiry 
■ Modify 
■ Properties 
■ Layers 
■ 3D Navigation 
■ Render 
■ Modeling 
■ Solid Editing 
■ UCS 
■ Workspaces 
■ Viewports 
■ Lights 
■ Mapping 
■ Visual Styles 
■ Camera Adjustment 
■ Walk and Fly

  

In the Workspace Contents pane, click Done.

Sa
mp
le
 C
ha
pt
er

Autodesk® Intellectual Property

Not Valid for S
ale or R

esale



14  ■ Chapter 1:  Customizing AutoCAD

4. In the Customize User Interface dialog box,  
click OK.

5. On the Workspaces toolbar, select Visualize.

Adjust the position of the toolbars by 
docking them to areas around the drawing 
area.

6. On the Workspaces toolbar, click Workspace 
Settings. In the Workspace Settings dialog 
box: 

■ Click Visualize. 
■ Click Add Separator. 
■ Click Automatically save workspace 

changes option. 
■ Click OK to save the settings.

  

Notice the toolbar positions may vary from 
one workspace to the other as the Standard 
and Styles toolbars are not included in all the 
workspace.

NOTE:  When you change the workspaces, 
you can see that the drawing area and the 
interface elements change to reveal the 
workspace settings. 

■ On the Workspaces toolbar, select 
AutoCAD Classic. 

■ On the Workspaces toolbar, select 
Visualize.

 

7. Close all files without saving.
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Lesson:  Creating Keyboard Shortcuts ■ 15

Lesson:  Creating Keyboard Shortcuts

Overview

In this lesson, you learn how to create keyboard shortcuts. You learn how macros and keyboard 
shortcuts are structured in the Customize User Interface dialog box, and how to create and 
manage them.

In its default configuration, the software interface offers tools that are common to most drafting 
disciplines, including architectural and mechanical. You can customize the standard interface to meet 
the requirements of your discipline by creating keyboard shortcuts, custom toolbars, macros, and 
other interface elements.

In the following illustration, a custom command is being added to the Shortcut Keys element in the 
Customize User Interface dialog box.

Objectives

After completing this lesson, you will be able to:

■  Describe customization files. 
■  Identify different parts of the Customize User Interface dialog box. 
■  Describe macros. 
■  Describe custom keyboard shortcuts. 
■  Work with custom keyboard shortcuts. 
■  State the guidelines for customization. 
■  Prepare the software for customization. 
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16  ■ Chapter 1:  Customizing AutoCAD

About Customization Files

Customization files store all the settings that you make to customize the user interface. Before 
customizing the user interface, you need to determine whether to create a new customization file or 
to modify the default file. You can modify customization files by using the Customize User Interface 
dialog box.

Definition of Customization Files

Customization files store configurations and settings that define the user interface. The default 
customization settings are stored in the acad.cui file. You can customize the acad.cui file by adding 
new elements such as menus, toolbars, and keyboard shortcuts. The CUI format supports versioning, 
which means that when you install a new version of the software on your computer, it automatically 
detects nondefault customization entries. However, it is recommended that you keep the default 
customization files separate from your customization settings.

Some of the benefits of creating customization files are:

■ You do not overwrite the critical core functionality provided by the default customization settings.
■ Future upgrades become simple because you can easily customize a new installation by adding 

your customization files to it.
■ You can prevent unwanted modifications to the default customization settings in a networked 

environment.

Configuring acad.cui as the enterprise customization file and creating a new main customization file 
is a better approach to customization. This method enables you to protect the default configuration 
from changes.

Example of Customization Files 

In the following illustration, the default acad.cui file is configured as the enterprise customization file. 
A new customization file mycustom.cui is configured as the main customization file. This configuration 
sets acad.cui as read-only and prevents any changes to it. All customization changes are written to 
mycustom.cui.

You can configure the main and enterprise customization files in the Files tab of the Options 
dialog box.
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Lesson:  Creating Keyboard Shortcuts ■ 17

Customize User Interface Dialog Box

The Customize User Interface dialog box is a single, common utility for customizing the interface. 
The Customize User Interface dialog box enables you to edit and organize the interface. You can also 
create elements such as toolbars, menus, keyboard shortcuts, and dashboard panels by using the 
Customize User Interface dialog box. 

Access

  

Customize User Interface

Command Line:  CUI

Menu:  Tools > Customize > Interface

Menu:  Tools > Workspaces > Customize

Toolbar:  Right-click any button > Customize

Toolbar:  Workspaces (List) > Customize

Dashboard:  Right-click any button > Customize Commands
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18  ■ Chapter 1:  Customizing AutoCAD

The Customize User Interface Dialog Box

The following illustration shows the Customize User Interface dialog box.

 

  Customizations in 

All CUI Files pane

Lists all elements currently loaded from customization files. Although 
the list displays all customization files by default, you can select a 
specific customization file from the list. In the tree view, categories of 
interface elements are displayed as nodes. You can expand each node 
to display the interface elements. 

  Command List pane Lists all commands currently loaded from customization files. You can 
use the Categories list to filter commands based on their group, such 
as Draw or Modify. You can also filter commands based on their 
source; for example, a specific CUI file. Additionally, you can show only 
custom commands in the Categories list.

  Preview/Button 

Image pane

Shows dynamic images. If you select a toolbar node in the 
Customizations in All CUI Files pane, the Preview Image pane displays 
a preview of the toolbar; if you select a command from the Command 
List, the Button Image pane displays the command.

  Properties pane Displays information specific to the element currently selected. You 
use this pane to name elements, write macros, and assign keyboard 
shortcuts.

  Transfer tab Enables you to transfer elements from one customization file to 
another. 
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Lesson:  Creating Keyboard Shortcuts ■ 19

About Macros

Macros combine a series of actions into one command that would otherwise have to be performed 
manually. They can vary in complexity. You typically use macros for creating keyboard shortcuts and 
toolbar buttons. 

Definition of Macros

A macro is a series of commands and instructions that are grouped together as a single command to 
automatically accomplish a task. Macros can be of any length and do not need special characters at 
the end of a line.

Special Characters used in Macros

The following table lists special characters used in macros.

Character Description

- Suppresses dialog box display of commands and makes all dialog box options 
available on the command line.

; Issues ENTER.

^M Issues ENTER.

^I Issues TAB.

[blank space] Enters a space. A blank space between instructions is equivalent to pressing 
SPACEBAR.

\ Pauses for user input. This character cannot be used with accelerators.

_ Provides international version support by translating standard English 
commands and options that follow into another language version of the 
software.

=* Displays the current top-level drop-down, shortcut, or image menu. 

^C^C^C Cancels all existing commands before proceeding with the macro.

$ Introduces a conditional DIESEL macro expression ($M=).

^B Turns Snap on or off. This character is equivalent to CTRL+B or F9.

^C Cancels a command. This character is equivalent to ESC.

^D Turns Coordinates on or off. This character is equivalent to CTRL+D or F6.

^E Sets the next isometric plane. This character is equivalent to CTRL+E or F5.

^G Turns Grid on or off. This character is equivalent to CTRL+G or F7.

^H Issues BACKSPACE.

^L Turns Ortho on or off. This character is equivalent to pressing F8.

^P Turns Menuecho on or off.
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20  ■ Chapter 1:  Customizing AutoCAD

Example of Macros

The following illustration represents a simple macro that automates the process of creating a circle 
with a 12-unit diameter by using the two-point option of the Circle command.

^T Turns table on or off. This character is equivalent to CTRL+T or F4.

^V Changes the current viewport.

^Z Enters a null character that suppresses the automatic addition of blank space at 
the end of a command.

Why Most Macros Begin with ^C^C^C
Most commands in macros begin with ^C^C^C, which is equivalent to pressing ESC three 
times. This is because some situations, such as dimensioning or grip editing, may require 
pressing ESC two or three times to cancel the existing command and clear the selection set. 
^C^C^C ensures that under most circumstances, the software is ready to receive the macros 
command sequence. 

 

  Escape cancels existing commands. 

  Underscore ensures that the macro executes regardless of the language version of the 
software.

  Circle sends the keystrokes of the Circle command to the command line.

  Spacebar begins the Circle command.

  2p sets the two-point option of the Circle command by sending the keystrokes to the 
command line.

  Semicolon simulates pressing ENTER and in this case, executes the 2p option.

  Backslash forces a pause for user input. In this case, it prompts the user to specify a start point 
for the circle.

  @12<0 sets relative coordinates to 12 units from the start point. This command specifies the 
size of the circle.

Refer to the software Help for information on complex macros.

Character Description
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Lesson:  Creating Keyboard Shortcuts ■ 21

About Custom Keyboard Shortcuts

You use keyboard shortcuts to assign key combinations to commands. A command or macro is 
executed when you press the assigned keyboard shortcut.

Several Windows® standard keyboard shortcuts, such as CTRL+A for select all and CTRL+Z for undo, are 
configured with the software by default. Other software-specific keyboard shortcuts, such as CTRL+2 
for Design Center and CTRL+L for Ortho toggle, are also configured by default.

Definition of Custom Keyboard Shortcuts

Keyboard shortcuts are alternatives to using mouse when working in the software. You can perform a 
variety of common tasks by using keyboard shortcuts. These shortcuts make it easier for you to 
interact with your computer.

You can create two types of keyboard shortcuts: shortcut keys and temporary override keys. By 
default, there are several keyboard shortcuts of each type in a standard AutoCAD installation.

Shortcut keys execute a command or macro when you press the configured key combination. 
Temporary override keys provisionally override drafting settings such as Snap, Tracking, Object Snap, 
and Dynamic Input. When you release override keys, the settings return to their original state.

The following illustration shows both types of keyboard shortcuts in the Customize User Interface 
dialog box.
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22  ■ Chapter 1:  Customizing AutoCAD

Example of Custom Keyboard Shortcuts

The following illustration shows a shortcut key. The macro for the shortcut key automates the steps to 
create a triangular polygon with text in the center. The key combination CTRL+T is configured to 
execute the macro.

Working with Keyboard Shortcuts

You use the Customize User Interface dialog box to create keyboard shortcuts. The dialog box displays 
both the categories of keyboard shortcuts in a tree view. To work with keyboard shortcuts, you can:

■ Create shortcut keys by using existing or custom commands.
■ Create temporary override keys.

Procedure:  Creating Shortcut Keys

The following steps describe how to create a shortcut key.

  Macro name 

  Macro command

  Configured key combination

1. On the command line or in the Dynamic Input interface, enter CUI.

2. In the Customize User Interface dialog box, Command List pane, click Create a New Command.
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Lesson:  Creating Keyboard Shortcuts ■ 23

3. In the Properties pane, enter the name and macro for the new command.

  

4. Expand the Keyboard Shortcuts node. From the Command List pane, drag the new command 
into Shortcut Keys in the tree view.

  

5. Select the command that you dragged into Shortcut Keys. In the Properties pane, click [...] in 
the Keys field to display the Shortcut Keys dialog box.
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24  ■ Chapter 1:  Customizing AutoCAD

 Procedure:  Creating Temporary Override Keys 

The following steps describe how to create a temporary override key.

6. Click the Press New Shortcut Key field and enter a key combination. The combination is 
displayed in the dialog box and you are informed whether it is already assigned or not. Assign 
the key combination to the command and close the Shortcut Keys dialog box.

  

7. Save the changes in the Customize User Interface dialog box and return to the drawing. Ensure 
that the new shortcut key is working by pressing the assigned key combination.

1. In the Customize User Interface dialog box, right-click the Temporary Override Keys node. 
Click New > Temporary Override.

  

2. In the Properties pane, enter the name, key combination, and macros for the override key.
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Lesson:  Creating Keyboard Shortcuts ■ 25

Guidelines for Customization

Creating new customization files, macros, and keyboard shortcuts helps you become more organized 
and efficient.

Guidelines for Working with Customization Files

Follow these guidelines to effectively customize the software:

■ Create a new customization file instead of modifying the default acad.cui file. This prevents 
unwanted modifications to the default customization settings in standalone and networked 
environments, and simplifies future upgrades.

■ Define the default acad.cui file as the enterprise customization file and create a new main 
customization file. This ensures that you do not run the risk of making unwanted changes to the 
default acad.cui file.

■ If you do not use an enterprise customization file, create the new customizations in a separate CUI 
file and load it as a partial CUI file in the default customization file. This ensures that no critical 
modifications happen on the default menus. 

■ Save the current workspace to the new main customization file if you are using workspaces 
to manage display configurations. This enables you to change your display configurations on 
new and existing drawings by selecting the workspace that you previously saved in the 
customization file.

Guidelines for Creating Keyboard Shortcuts

Follow these guidelines to effectively create keyboard shortcuts:

■ Use temporary override keys to execute a transparent command or change a setting only when a 
key is pressed. These shortcuts can execute one macro while the key is down and the other macro 
after the key is released.

■ Use temporary override keys when you are in point acquisition mode. This gives you more control 
and precision when trying to acquire a point on an object.

Guidelines for Creating Macros

Follow these guidelines to effectively create macros:

■ Use macros to simplify commands combined with special characters to automate the task for 
effective and timely use.

■ Understand the special characters used in macros and their functions before creating macros. 
Remember that every character in a macro is significant, including a blank space.

■ Begin all macros with three instances of ̂ C. This ensures that the existing commands are canceled 
and the selection set is clear.

3. Save the changes. Ensure that the new temporary override key is functional by starting a 
command and pressing the key when prompted to select a point. Notice the temporary 
override indicator near the crosshairs.
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26  ■ Chapter 1:  Customizing AutoCAD

Exercise:  Prepare the Software for Customization

In this exercise, you prepare the software for 
customization by creating a customization folder, 
creating a new customization file, and then defining 
the new file as the main customization file.

You have just upgraded the AutoCAD installation on 
your computer to the current release and you need 
to customize your interface by adding a custom 
workspace.

You do the following:

■ Create a new customization file.
■ Define a customization file as the main 

customization file.

Create a New Customization File

Define a Customization File as the Main 

Customization File

 
The completed exercise

Completing the Exercise
To complete the exercise, follow the 
steps in this book or in the onscreen 
exercise. In the onscreen list of 
chapters and exercises, Click Chapter 1: 
Customizing AutoCAD. Click Exercise: 
Prepare the Software for Customization.

1. Create a new drawing. 

2. Click Tools menu > Customize > Interface.

3. In the Customize User Interface dialog box, 
Transfer tab, Customizations in New CUI File 
pane, select Save As from the list.

  

4. In the Save As dialog box: 

■ Navigate to the location where student 
datasets are installed. 

■ Create a folder named Customization. 
■ Double-click the customization folder to 

open it. 
■ For file name, enter MyCustom. 
■ Click Save.

5. Notice that the name of the Customizations 
in New CUI File pane has changed to 
Customizations in Mycustom.cui.

6. In the Customize User Interface dialog box, 
Click OK.

1. To change the location of the CUI files, right-
click anywhere in the drawing. Click Options.

2. In the Options dialog box, Files tab, expand 
Customization Files.

3. Under Customization Files: 

■ Expand Main Customization File. 
■ Expand Enterprise Customization File.

Sa
mp
le
 C
ha
pt
er

Autodesk® Intellectual Property

Not Valid for S
ale or R

esale



Lesson:  Creating Keyboard Shortcuts ■ 27

4. Copy the path of the main customization file 
and paste it for the path of the enterprise 
customization file.

5. To specify the main customization file, in the 
Options dialog box: 

■ Select the path of the main 
customization file. 

■ Click Browse.

6. In the Select a File dialog box: 

■ Navigate to the Customization folder 
that you created in step 4 of the previous 
exercise table. 

■ Select the MyCustom.cui file. 
■ Click Open.

7. Ensure that: 

■ mycustom.cui is set as the main 
customization file. 

■ The path of the enterprise customization 
file is set to C:\Documents and 
Settings\username\Application 
Data\Autodesk\AutoCAD 
2008\R17.1\enu\support\acad.cui

8. In the Options dialog box, Files tab: 

■ Expand Support File Search Path. 
■ Click Add. 
■ Click Browse.

9. In the Browse for Folder dialog box: 

■ Navigate to the Customization folder 
that you created in step 4 of the previous 
exercise table. 

■ Click OK.

10. Click OK to close the Options dialog box.

NOTE:  You can use the Customizations folder 
to store other files related to customization. 
Adding the folder location as Support File 
Search Path enables the software to find 
customization files located in the folder.

11. On the command line, enter CUI. 
Press ENTER.

12. In the Customize User Interface dialog box, 
Customizations in All CUI Files pane, 
notice that: 

■ A new customization file MYCUSTOM is 
displayed. 

■ The default customization file ACAD is 
displayed as read-only.

  

13. In the Customize User Interface dialog box, 
click OK.

14. On the Workspaces toolbar, select Save 
Current As from the list.

  

15. In the Save Workspace dialog box: 

■ For Name, enter My Customized. 
■ Click the Name list to display the default 

workspaces. 
■ Notice the read-only attribute associated 

with the workspaces.

  

Sa
mp
le
 C
ha
pt
er

Autodesk® Intellectual Property

Not Valid for S
ale or R

esale



28  ■ Chapter 1:  Customizing AutoCAD

NOTE:  The read-only attribute is associated 
with the workspaces in the Name list 
because they are part of the acad.cui file that 
you have configured as the enterprise 
customization file.

16. In the Save Workspace dialog box: 

■ Collapse the Name list.
■ Click Save.

17. Right-click any toolbar. Click Customize.

18. In the Customize User Interface dialog box, 
notice that the My Customized workspace is 
automatically created in the MYCUSTOM file.

  

19. Click OK to close the Customize User 
Interface dialog box.

20. Close all files without saving.
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Exercise:  Create a Keyboard Shortcut

In this exercise, you create a shortcut key to 
automate the process of creating a revision tag in 
your drawing. You create the keyboard shortcut for 
using the Polygon command to create a triangle and 
then use the Text command to automate text 
justification in the center of the triangle. 

You have designed a mounting bracket to which 
multiple changes have been made by the Engineer. 
You need to document the changes by placing 
revision tags in the drawing.

You do the following:

■ Assign macro to a keyboard shortcut.
■ Create a shortcut key.

Assign Macro to a Keyboard Shortcut

The macro created in this exercise is 
assigned to a keyboard shortcut. You 
can assign the same macro to a menu 
or toolbar, depending on your design 
requirements.

 The completed exercise

Completing the Exercise
To complete the exercise, follow the 
steps in this book or in the onscreen 
exercise. In the onscreen list of 
chapters and exercises, Click Chapter 1: 
Customizing AutoCAD. Click Exercise: 
Create a Keyboard Shortcut.

1. Open c_create_keyboard_shortcut.dwg.

2. On the command line, enter CUI. 
Press ENTER.

3. In the Customize User Interface dialog box, 
Command List pane, click Create a New 
Command.

4. In the Properties pane:

■ For Name, enter Revision Tag. 
■ For Macro, enter

^C^C^C_polygon;3;\C;.5;text;J;M;@;.5;; \.

 

NOTE:  This macro starts the Polygon 
command and specifies 3 sides. It pauses for 
you to select a point and then specifies the 
Circumscribed option and a .5 unit radius. 
It then starts the Text command, uses the 
Justify option, and specifies a Middle 
justification. For the text position, it uses the 
@ symbol to specify the last point selected, 
that is, the center of the triangle. The macro 
then specifies .5 for the text height and uses 
the default value for the rotation angle. 
Finally, the macro pauses for user input of the 
text value.
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Create a Shortcut Key

1. In the Customize User Interface dialog box: 

■ In the Command List pane, select 
Custom Commands from the list to 
display only custom commands.

■ In the Customizations in All CUI Files 
pane, expand Keyboard Shortcuts.

■ Drag the Revision Tag command into 
Shortcut Keys.

  

2. With the new shortcut key selected, in the 
Properties pane: 

■ Click the Key(s) field. 
■ Click [...].

  

3. In the Shortcut Keys dialog box: 

■ In the Press New Shortcut Key field, press 
CTRL+T. 

■ Click OK to close the dialog box.

  

4. Click OK to close the Customize User 
Interface dialog box.

5. On the application status bar, ensure that 
object snaps is turned off.

6. In the drawing area: 

■ Press CTRL+T to activate the new 
shortcut key 

■ At the Specify Center of Polygon prompt, 
select a point to place the revision tag, 
as shown.

■ At the Enter Text prompt, enter 1. 
Press ENTER.

  

7. Close all files without saving.
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Lesson:  Customizing Toolbars

Overview

This lesson describes how to customize toolbars. Toolbars are one of the most commonly used 
interface elements in any Microsoft® Windows® application. 

You can customize toolbars to create an interface that provides quick access to the tools that you use 
most frequently.

The following illustration shows a customized toolbar that offers additional versions of the Circle 
command.  

Objectives

After completing this lesson, you will be able to:

■  Describe custom toolbars. 
■  Identify various toolbar menu options in the Customize User Interface dialog box. 
■  Customize toolbars. 
■  State the guidelines for customizing toolbars. 
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About Custom Toolbars

Custom toolbars can vary in complexity from just a few buttons with standard commands to complex 
toolbars containing many flyouts. Complex custom toolbars can also include custom macros, which 
can be used to launch custom applications. You can begin customizing toolbars by adding tools that 
are not available on any of the standard toolbars.

The following illustration shows the customized Draw toolbar, which includes flyout toolbars for 
drawing arcs and circles. 

Definition of Custom Toolbars

A custom toolbar is a toolbar that is modified and customized according to your specific requirements. 
Custom toolbars comprise groups of buttons, where each button represents a predefined or custom 
command.

You use the Customize User Interface dialog box to customize toolbars. The custom toolbar buttons 
represent commands under the Command List pane. Icons associated with each toolbar button are 
part of the command’s definition and are created under the Button Image pane of the Customize User 
Interface dialog box.
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The following illustration shows a custom toolbar button in the Customize User Interface dialog box.

 

  Command under the Command List pane

  Command assigned to a custom toolbar

  Image assigned to the command under the Button Image pane

  Properties of the command under the Properties pane

  Filenames for the image
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Flyouts

A flyout is a set of buttons that is nested under a single button on a toolbar. Flyout buttons on 
a toolbar have a black triangle in their lower-right corner. You can convert both standard and custom 
toolbars into flyouts. 

The following illustration shows a flyout in the Customize User Interface dialog box. Notice that flyout 
and the source toolbar contain the same commands. If you delete a command from the source toolbar 
list, it is also deleted from the flyout definition list. The source toolbar name for the flyout appears as 
read-only. This name is the first alias assigned to the source toolbar and is referenced automatically 
when you define a new flyout.

 

  Flyout on a custom toolbar

  Source toolbar for the flyout

  Name of the source toolbar
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Toolbar Aliases

When you create a flyout, the name of the source toolbar is not used to reference the toolbar. Instead, 
you reference a flyout by using the first alias of the source toolbar. An alias is created automatically 
when you create a new toolbar. Aliases are easily overlooked and lead to confusion when reading the 
Source Toolbar property for a flyout. This is because most toolbars are renamed by using the Name 
property, but renaming the alias name may be overlooked.

NOTE:  A toolbar can have more than one alias, but the alias that appears first is used for flyout 
reference.

The following illustration shows the source toolbar alias for a flyout and the Aliases dialog box.

Example of Custom Toolbars

The following illustration shows a customized version of the standard Draw toolbar. 

 

  Toolbar name

  Toolbar alias

  Toolbar alias in the Aliases dialog box
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Toolbar Menu Options

Toolbar menu options in the Customize User Interface dialog box enable you to customize toolbars. 
You use the toolbar menu options to create, organize, copy, and modify toolbar elements, as required. 
You can also create new toolbars with flyouts by using the toolbar menu options.

Access

Toolbar Menu Options

The following menu options are displayed when you right-click a toolbar under the Customizations in 
All CUI Files pane in the Customize User Interface dialog box.

  

Customize User Interface

Command Line:  CUI

Menu:  Tools > Customize > Interface

Menu:  Tools > Workspaces > Customize

Toolbar:  Right-click any button > Customize

Toolbar:  Workspaces (List) > Customize

Dashboard:  Right-click any button > Customize Commands
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Customizing Toolbars

You can customize or create toolbars by rearranging and adding standard toolbar buttons, and 
creating new commands. You use the Customize User Interface dialog box to create all the elements 
required for a custom toolbar.

The following illustration shows a flyout added to a toolbar. The flyout contains buttons for predefined 
and custom commands.

Option Description

Insert Separator Places a separator element between the currently selected tool or command 
and the element below.

NOTE:  A separator is a blank interface element that appears as a line between 
commands on a toolbar.

New Toolbar Creates a blank toolbar. The new toolbar appears at the bottom of the 
toolbar list under the Customizations in All CUI Files pane.

New Flyout Creates a blank toolbar and locates it immediately below the selected 
element. 

Rename Renames the currently selected element.

Delete Deletes the currently selected element.

Duplicate Creates a duplicate copy of the selected element under the currently 
active node.

Copy Creates a copy of the currently selected element.

Paste Pastes the copied element.

Find Displays the Find and Replace dialog box, which can be used to search the 
user interface elements for specific words.

Replace Displays the Find and Replace dialog box, which can be used to search for 
and replace specific text within the user interface elements.
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Procedure:  Customizing Toolbars

The following steps describe how to customize toolbars.

1. Open the Customize User Interface dialog box.

2. In the Customize User Interface dialog box, Customizations in All CUI Files pane, expand the 
Toolbars group to display the list of toolbars.

3. Right-click the toolbar group in which you want to create the new toolbar and click 
New Toolbar.

  

NOTE:  For creating a flyout, right-click the toolbar on which you want to create the flyout and 
click New Flyout.

4. Under the Properties pane, specify various properties for the toolbar/flyout. 
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Guidelines for Customizing Toolbars

Customizing toolbars enables you to maximize the usable drawing space and become more 
productive in your daily projects. 

Guidelines for Customizing Toolbars

Follow these guidelines to effectively customize toolbars.

■ Before customizing toolbars, determine whether creating a toolbar would suit you best because 
some customization options might be better placed on a toolbar, while others might serve you 
better as keyboard shortcuts or double-click actions.

■ Name toolbars and flyouts appropriately when you create them. You should also change the alias 
name to match, unless the toolbar name has already been used as a source for a flyout.

■ Do not change the alias of a toolbar after it has been referenced as a flyout because the link 
between the source toolbar and the toolbar referencing the flyout gets lost.

■ Copy the toolbar that you need to modify and make the required changes, when customizing a 
standard toolbar.

5. Under the Command List pane, select the commands for the toolbar/flyout and drag them 
onto the toolbar under the Customizations in All CUI Files pane.

TIP:  You can select multiple commands and drag them onto the toolbar by using the standard 
Windows® multiple selection keys: SHIFT and CTRL.

  

6. Save the changes and close the Customize User Interface dialog box. Ensure that the custom 
toolbar is working by using the additional commands.
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Exercise:  Customize Toolbars

In this exercise, you use the Customize User Interface 
dialog box to copy the default Draw toolbar to a new 
customization file. You then add a flyout consisting 
of other predefined commands for creating circles to 
the toolbar.

You are working on a project that requires you to 
repeatedly draw circles. Therefore, you create a 
custom Draw toolbar, which contains all the circle 
commands that you need to complete the project.

You do the following:

■ Create a custom toolbar.
■ Add a flyout to a toolbar.

Prerequisite

Before taking this exercise, you should have created 
your main and enterprise customization files in the 
Prepare the Software for Customization exercise. To 
complete the Prepare the Software for 

Customization exercise, in the onscreen list of 
chapters and exercises, click Chapter 1: Customizing 
AutoCAD. Click Exercise: Prepare the Software for 
Customization.

Create a Custom Toolbar

The completed exercise 

Completing the Exercise
To complete the exercise, follow the 
steps in this book or in the onscreen 
exercise. In the onscreen list of 
chapters and exercises, click Chapter 1: 
Customizing AutoCAD. Click Exercise: 
Customize Toolbars.

1. Open c_customize_toolbars.dwg.

2. On the dashboard, right-click the 2D Draw 
control panel. Click Customize Commands.

3. In the Customize User Interface dialog box, 
Customize tab, Customizations in All CUI 
Files pane:

■ Ensure that the ACAD customization tree 
is expanded.

■ Under the ACAD customization tree, 
expand Toolbars.

■ Drag the Draw toolbar into the Toolbars 
node under MYCUSTOM customization 
tree, as shown.

  

NOTE:  In this step, You create a copy of the 
original Draw toolbar because it is a part of 
the Enterprise Customization file and cannot 
be modified.
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Add a Flyout to a Toolbar

4. Under the MYCUSTOM customization tree, 
Toolbars node:

■ Right-click the new Draw toolbar 
element. Click Rename.

■ For name, enter Custom-Draw.

  

5. Under the MYCUSTOM customization tree:

■ Ensure that the Workspaces element is 
expanded.

■ Click the My Customized (current) 
workspace.

6. In the Workspace Contents pane, click 
Customize Workspace.

7. In the Customizations in All CUI Files pane, 
MYCUSTOM customization tree, ensure 
that a checkmark is displayed next to the 
Toolbars node.

8. In the Workspace Contents pane:

■ Expand the Toolbars node.
■ Drag the Custom-Draw toolbar to the top 

of the list, as shown.

  

■ Click Done.

9. Click OK to close the Customize User 
Interface dialog box.

10. In the drawing area:

■ Drag the docked Draw toolbar from the 
left of the screen to show its name.

■ Verify that the name of the toolbar is 
Custom-Draw.

■ Dock the toolbar to its default location, 
that is, the left of the drawing area.

1. In the drawing area: 

■ Right-click the Custom-Draw toolbar.
■ Verify that the Custom-Draw toolbar is 

the only toolbar displayed in the shortcut 
menu. Click Customize.

  

NOTE:  The Custom-Draw toolbar is the 
only item listed in the shortcut menu 
because it is the only toolbar defined in 
the mycustom.cui file.

2. In the Customize User Interface dialog box: 

■ Expand the Customizations in All CUI 
Files pane.

■ Collapse the Custom-Draw toolbar 
element.

■ Right-click Toolbars. Click New Toolbar.
■ For name, enter Circles.
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3. In the Customize User Interface dialog box, 
click the Show Properties Pane icon to 
display the Properties pane.

  

4. In the Properties pane: 

■ Click the Aliases field to display [...].
■ In the Aliases field, click [...] to display the 

Aliases dialog box.

5. In the Aliases dialog box: 

■ Delete the Toolbar1 default alias.
■ For alias, enter Circles.

  

■ Click OK to close Aliases dialog box.

6. In the Command List pane: 

■ Select Draw from the list.
■ Select the commands related to circles 

by holding down SHIFT and clicking the 
commands.

■ Drag the selected commands into the 
Circles toolbar in the Customizations in 
All CUI Files pane, as shown.

  

7. In the Customizations in All CUI Files pane: 

■ Expand the Custom-Draw toolbar.
■ Drag the Circles toolbar into the Custom-

Draw toolbar and position the Circles 
toolbar under the existing Circle 
command, as shown.
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8. In the Customizations in All CUI Files pane, 
Toolbars node, Custom-Draw toolbar, right-
click Circle. Click Remove.

9. Click OK to close the Customize User 
Interface dialog box.  

10. In the drawing area, verify that a flyout is 
created on the Draw toolbar.

  

11. Close all files without saving.
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Lesson:  Customizing Dashboard Panels

Overview

In this lesson, you learn how to customize dashboard panels. 

You can customize dashboard panels to display the commands and tools you use frequently in the 
same way as you create custom tool palettes and custom toolbars. Using dashboard control panels, 
you can quickly access commands and reduce the number of user interface elements displayed on 
your drawing area. This enables you to maximize the amount of drawing area that is available. The 
dashboard panel has an advantage over toolbars and tool palettes because it replaces many interfaces 
within a single interface.

For example, you are frequently using the Zoom commands from the View menu because they are not 
available on the 2D Navigate control panel. Therefore, you create a custom control panel with a flyout 
that contains all the needed tools.

Objectives

After completing this lesson, you will be able to:

■  Describe custom dashboard panels. 
■  Identify various dashboard panel menu options in the Customize User Interface dialog box. 
■  Create custom dashboard panels. 
■  State the guidelines for customizing dashboard panels. 
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About Custom Dashboard Panels

Custom dashboard panels can vary in complexity from just a few buttons with standard commands to 
complex dashboard panels containing many flyouts, drop-down lists, sliders, and text boxes. You can 
begin customizing dashboard panels by adding tools that are not available on any of the standard 
dashboard panels.

Definition of Custom Dashboard Panels

A custom dashboard panel is a control panel that has been created or modified according to your 
specific requirements. You can modify an existing control panel or create a new control panel that 
contains only the required tools.

To customize control panels, use the Customize User Interface dialog box. Each control panel is 
separated into rows and each row has the control buttons which represent commands in the 
command list pane. Icons associated with each control button are part of the definition of the 
command and are created in the Button Image pane. Also, each panel contains a Panel Separator that 
allows you to separate rows within the panel. You might want to separate rows within a control panel 
that contain commands that are not used as often or are unique and would be used only with a 
particular type of drawing.

Example of Custom Dashboard Panels 

The following illustration shows a custom control panel similar to the Standard toolbar. This panel 
allows you to access standard tools from the dashboard instead of the toolbar.

Dashboard Panel Menu Options

You use the dashboard panel menu options to customize the dashboard panels by creating, 
organizing, copying, and modifying dashboard elements, as needed. These options are available in 
the Customize User Interface dialog box. You can also create new dashboard panels with flyouts by 
using the dashboard panel menu options.

Access

 

  

Customize User Interface

Command Line:  CUI

Menu:  Tools > Customize > Interface

Menu:  Tools > Workspaces > Customize

Toolbar:  Right-click any button > Customize

Toolbar:  Workspaces (List) > Customize

Dashboard:  Right-click any button > Customize Commands
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Dashboard Panel Menu Options

The following menu options are displayed when you right-click a dashboard panel and a dashboard 
panel row under the Customizations in All CUI Files pane in the Customize User Interface dialog box.

  

  

Right-click menu for dashboard panels Right-click menu for dashboard panel rows

Option Description

New Panel Creates a blank control panel.

NOTE:  The new control panel appears at the bottom of the panel list under the 
Customizations in All CUI Files pane.

New Row Creates a blank row on the selected control panel.

New Flyout Creates a flyout and places it immediately below the selected element.

NOTE:  A flyout is a single control that allows you to place several controls within it., The 
flyout appears only when you activate it. The New Flyout option is only available when a 
Row is selected.

Add 

Separator

Places a separator element between the currently selected tool and the element below it.

NOTE:  A separator is a blank interface element that appears as a line between commands 
on a control panel. The Add Separator option is only available when a Row is selected.

Rename Renames the currently selected element.

NOTE:  The Rename option is only available when the control panel name is selected.

Duplicate Creates a duplicate copy of the selected element under the currently active node.

Copy Creates a copy of the currently selected element.

Paste Pastes the copied element.

Find Displays the Find and Replace dialog box, which can be used to search the user interface 
elements for specific words.

Replace Displays the Find and Replace dialog box, which can be used to search and replace 
specific text within the user interface elements.
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Creating Custom Dashboard Panels

You can customize or create dashboard panels by rearranging and adding standard buttons, and 
creating new commands. The software provides various predefined dashboard panels. You can also 
use the Customize User Interface dialog box to create custom dashboard panels that better suit your 
requirements.

The following illustration shows a custom dashboard panel, which contains buttons for several 
frequently used dimensioning commands.

Procedure:  Creating Custom Dashboard Panels

The following steps describe how to create a custom dashboard panel.

 

1. Open the Customize User Interface dialog box. 

2. In the Customize User Interface dialog box, Customizations in All CUI Files pane, expand the 
Dashboard Panels node to display the list of control panels.

3. Right-click any of the displayed control panels to create the new panel and click New Panel.

  

4. Under the Properties pane, specify properties such as name, description, and image.
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5. Under the Command List pane, select the required commands for the control panel and drag 
them onto the panel under the Customizations in All CUI Files pane.

  

TIP:  You can select multiple commands and drag them onto the panel by using the standard 
Windows® multiple selection keys, SHIFT and CTRL.

6. Save the changes and close the Customize User Interface dialog box. Ensure that the custom 
dashboard panel appears on the Dashboard Window.

  

TIP:  If you want to rearrange the tools in your new panel, you can easily drag the tools around 
in the Panel Preview pane of the Customize User Interface dialog box.Sa
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Guidelines for Customizing Dashboard Panels

Dashboard panels are similar to toolbars but they give you more flexibility and control on how the 
tools you use frequently are displayed and organized. Customizing dashboard panels enables you to 
maximize the usable drawing space and become more productive in creating drawings. Dashboard 
panels allow you to quickly access tools and commands, which helps you work more effectively and 
efficiently. Do not create custom control panels for every command and tool, this would only increase 
your customizing effort.

Guidelines for Customizing Dashboard Panels

■ Before customizing dashboard control panels, determine whether creating a control panel suits 
you best or if another customization option might serve your needs better such as keyboard 
shortcuts, double-click actions, toolbars, or tool palettes.

■ Place panel separator between the commands that you use frequently and those that you don’t 
use as frequently. This helps you organize the panel in a better manner.

■ When creating or modifying a control panel, the number of rows required will vary depending on 
the number of commands and controls added to the control panel. This will provide easy access 
to the most frequently used commands. 

■ When customizing a standard control panel, copy the control panel that you need to modify and 
make the required changes from there. This helps you avoid making and saving changes to the 
standard panel.

■ You can select multiple commands and drag them onto the panel by using the standard Windows® 
multiple selection keys, SHIFT and CTRL.
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Exercise:  Create Custom Dashboard Panels

In this exercise, you create a custom dashboard 
panel.

You have just installed the latest updates for your 
software and want to enhance the standard 
dashboard by adding custom dashboard panels to 
enhance your workflow. Therefore, you create 
custom Dimension and 2D Navigate control panels.

Prerequisite

Before taking this exercise, you should have created 
your main and enterprise customization files in the 
Prepare the Software for Customization exercise. 
To complete the Prepare the Software for 
Customization exercise, in the onscreen list of 
chapters and exercises, click Chapter 1: Customizing 
AutoCAD. Click Exercise: Prepare the Software for 
Customization.

The completed exercise 

Completing the Exercise
To complete the exercise, follow the 
steps in this book or in the onscreen 
exercise. In the onscreen list of 
chapters and exercises, click Chapter 1: 
Customizing AutoCAD. Click Exercise: 
Create Custom Dashboard Panels.

1. Open a new acad.dwt template drawing.

2. Right-click anywhere on the dashboard and 
click Customize Commands to open the 
Customize User Interface dialog box. 

3. In the Customize User Interface dialog box, 
Customize tab, Customizations in All CUI 
Files pane:

■ Ensure that the ACAD customization tree 
is expanded.

■ Expand the Dashboard Panels node.
■ Drag the Dimensions panel onto the 

Dashboard Panels node under the 
MYCUSTOM customization tree.

4. Under the MYCUSTOM customization tree, 
Dashboard Panels node:

■ Right-click the Dimensions control panel 
element.

■ Click Rename.

  

5. Under the Properties pane, for name, enter 
Custom-Dimensions.
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6. Repeat steps 3 and 4 to create a custom 
Control panel for 2D Navigate and rename it 
to Custom-2D Navigate.

  

7. Expand the nodes on both Custom-
Dimensions and Custom-2D Navigate 
control panels. 

  

NOTE:  Verify that both control panels are 
similar with two rows and no elements 
placed on the panel separators.

8. Under the Custom-Dimensions panel, right-
click Panel Separator and click New Row. 

NOTE:  Row 3 is added to the panel below the 
panel separator.

9. To add commands to the Custom-
Dimensions panel:

■ Expand Row 1 node on the Custom-
Dimensions panel.

■ While holding the CTRL key down, select: 
Arc Length, Ordinate, Jogged, 
Dimjogline, Baseline, Continue, 
Diminspect, Dimbreak, and Dimspace.

■ Press the CTRL+SHIFT keys and drag the 
selected commands onto the new row 
called Row 3.

  

10. Under the Panel Preview pane, verify that 
Rows 1 and 2 are separated from Row 3 by 
the Panel Separator line.
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11. Under the Customizations in all CUI Files 
pane, Custom-2D Navigate control panel:

■ Expand Row 1 node.
■ Right-click Row 1 node.
■ Select New Flyout.

  

NOTE:  Ensure that a blank bottom was added 
in the Panel Preview at the end of the Row 1.

12. Under the Command List pane:

■ Select View from the Categories list.
■ Select all the Zoom commands by 

holding the SHIFT key down and clicking 
the commands.

■ Drag the selected command to the 
Flyout 1 control panels as shown.

  

13. Under the Customizations in all CUI Files 
pane, Workspaces node, click My 
Customized.

14. Under the Workspace Contents pane:

■ Expand the Dashboard Panels node.
■ Holding the CTRL key down, select 

Dimensions and 2D Navigate control 
panels.

  

■ Right-click the selection and click 
Remove from Workspace.

15. Click Apply to save the changes and click OK 
to close the Customize User Interface dialog 
box.

16. Ensure that the new dashboard panels 
appear on the Dashboard window as shown.

  

17. Close all files without saving.
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Lesson:  Creating and Modifying 

Double-Click Actions

Overview

This lesson describes how to use double-click actions to customize the behavior of the software when 
specific type of objects are double-clicked.

Double-click actions provide a powerful method of quickly editing objects in a drawing. Double-click 
actions enable you to be more productive and better equipped to create drawings. Using double-click 
actions, you can quickly access editing commands for the object type that you double-click in a 
drawing. 

The following illustration shows the execution of the Xclip command on double-clicking an external 
reference object. 

Objectives

After completing this lesson, you will be able to:

■  Describe double-click actions. 
■  Create and modify double-click actions. 
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About Double-Click Actions

Double-click actions enable you to execute specific commands when you double click a specific 
object.  The commands can range from displaying the Properties palette to executing any other 
command. Double-click actions link to object names or instances of objects used in a drawing. Prior to 
AutoCAD 2007, double-click actions were hard coded and could not be customized.

Definition of Double-Click Actions

Double-click actions make editing commands accessible when you place the cursor over an object in 
a drawing and register a double-click from a pointing device. Double-click actions are object-type 
sensitive, enabling you to set up a specific command for a specific object type.

A list of the double-click actions stored in a customization file is displayed under the Customizations 
in All CUI Files pane in the Customize User Interface dialog box.

Each double-click action consists of three main properties: 

■ Name
■ Object name
■ Associated command

When you double-click an object, the object name is evaluated and correlated with a double-click 
action, and then the command associated with that double-click action is executed. If no command is 
assigned to the object, the Properties palette is displayed. 

The following illustration shows the Xref View Edit double-click action and its properties in the 
Customize User Interface dialog box. The Clip.Xref command is assigned to the XREF object. 

  Double-click action   Name of associated object

  Associated command

The PICKFIRST system variable affects the execution of the double-click action. If you set 
PICKFIRST to zero, the double-click action is not executed. This is because PICKFIRST controls 
whether you can select objects before executing a command.

The DBLCLKEDIT system variable also determines whether the command associated with a 
double-click action is executed. If DBLCLKEDIT is set to 0 or off, the double click action is not 
executed, even if PICKFIRST is set to 1.
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Example of Double-Click Actions

The following illustration shows the default action for double-clicking blocks. In the default action, 
when a window is double-clicked, it is evaluated as a block and the Edit Block Definition dialog box is 
displayed. You can modify this default action for double-clicking blocks to execute a different 
command.

Creating and Modifying Double-Click Actions

By default, several double-click actions already exist. You can use the Customize User Interface dialog 
box to create new and modify existing double-click actions. Each double-click action is associated with 
a predefined or custom command. 

You can:

■ Create double-click actions.
■ Modify the commands associated with double-click actions.

Access

 

  

Customize User Interface

Command Line:  CUI

Menu:   Tools > Customize > Interface

Menu:   Tools > Workspaces > Customize

Toolbar:  Right-click any button > Customize

Toolbar:  Workspaces (List) > Customize

Dashboard:  Right-click any button > Customize Commands
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Procedure:  Creating Double-Click Actions

The following steps describe how to create a double-click action for an object type.

1. In the Customize User Interface dialog box, under Customizations in All CUI Files pane, right-
click Double Click Actions and click New Double Click Action. 

  

2. Specify a name for the double-click action.

  

NOTE:  The default double-click actions use the object name for which they are used. However, 
you can modify the default action name.

3. Under the Properties pane, for Object Name, enter the name of the object for which you want 
to use the double-click action.

  

Sa
mp
le
 C
ha
pt
er

Autodesk® Intellectual Property

Not Valid for S
ale or R

esale



Lesson:  Creating and Modifying Double-Click Actions ■ 57

4. Under the Command List pane, select the command that you want to execute for the double-
click action and drag it into the new double-click action under the Customizations in All CUI 
Files pane.

  

5. Save the changes in the Customize User Interface dialog box.

  

6. In the drawing area, create\insert an object that has the same object name as the object used 
for the new double-click action.
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Procedure:  Modify Commands Associated with Double-Click Actions

The following steps describe how to modify the command associated with a double-click action.

7. Ensure that the new double-click action is working for the drawing object.

  

1. In the Customize User Interface dialog box, under Customizations in All CUI Files pane, expand 
Double Click Actions. 
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2. Under the Command List pane, select the command that you want to execute for the double-
click action and drag the command into the double-click action to replace the existing 
command.

  

3. Save the changes in the Customize User Interface dialog box.

4. In the drawing area, create an object that has the same object name as the double-click action 
that you just modified. 

5. Ensure that the new double-click action is working for the drawing object.
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Exercise:  Create a Double-Click Action

In this exercise, you create a double-click action for a DWF™ underlay and assign the DWF Clip command to 
the double-click action.

You are working with a DWF underlayed floor plan as part of your project. You decide to create a double-click 
action that would enable you to quickly edit the view of the underlayed DWF floor plan.

Prerequisite

Before taking this exercise, you should have created 
your main and enterprise customization files in the 
Prepare the Software for Customization exercise. To 
complete the Prepare the Software for 
Customization exercise, in the onscreen list of 
chapters and exercises, click Chapter 1: Customizing 
AutoCAD. Click Exercise: Prepare the Software for 
Customization.

The completed exercise 

Completing the Exercise
To complete the exercise, follow the 
steps in this book or in the onscreen 
exercise. In the onscreen list of chapters 
and exercises, click Chapter 1: 
Customizing AutoCAD. Click Exercise: 
Create a Double-Click Action.

1. Create a new drawing. 

2. Click Tools menu > Customize > Interface.

3. In the Customize User Interface dialog box, 
under the Customizations in All CUI Files 
pane:

■ Ensure that All Customization Files is 
selected from the list.

Sa
mp
le
 C
ha
pt
er

Autodesk® Intellectual Property

Not Valid for S
ale or R

esale



Lesson:  Creating and Modifying Double-Click Actions ■ 61

■ In the tree view, under the MYCUSTOM 
node, right-click Double Click Actions. 
Click New Double Click Action.

  

4. Enter DWF Underlay for the name of the 
new double-click action.

5. Under the Properties pane, for Object Name, 
enter DWFUNDERLAY.

TIP:  If you are not sure about the object 
name for an object, in most cases you can 
create the object in a drawing and use the 
AutoLISP® code given below. To use the 
AutoLISP code, enter it on the command line 
or the dynamic input tooltip and select the 
object in question when prompted to do so. 
The value you need to enter in the Object 
Name property of the double-click action is 
displayed in the Text Window.

  

6. In the Customize User Interface dialog box:

■ Under the Command List pane, click the 
DWF Clip command.

■ Drag the DWF Clip command into DWF 
Underlay.

  

7. Click OK to close the Customize User 
Interface dialog box.

8. In the drawing area, click File menu > New.

9. In the Select Template dialog box, click the 
arrow icon next to the Open button. Click 
Open with no Template - Imperial. 

NOTE:  If the Create New Drawing dialog box 
is displayed, click Start from Scratch, click 
Imperial (feet and inches), and then click OK.

10. Save the empty drawing with a name of your 
choice.

11. Click Insert menu > DWF Underlay.

12. In the Select DWF File dialog box:

■ Navigate to the location where student 
datasets are installed.

■ Click i_floorplan_with_foundation.dwf.
■ Click Open.
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13. In the Attach DWF Underlay dialog box:

■ Ensure that the check marks next to all 
the Specify On-screen options are 
cleared.

■ Under Path Type, ensure that Full Path is 
selected.

  

■ Click OK.

14. On the dashboard, 2D Navigate control 
panel, click Extents.

  

15. In the drawing area, double-click the frame 
of the attached DWF file.

NOTE:  If the frame for the attached DWF file 
is not displayed, Enter DWFFRAME on the 
command line and set the system variable
 to 1.

16. Verify that the DWF Clip command is 
working.

  

17. Close all files without saving.
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Lesson:  Customizing Menus

Overview

This lesson describes how to create custom menus by using the Customize User Interface dialog box.

You customize menus to create an interface that provides easy access to commands that you use on 
a regular basis. Custom menus also enable you to be more organized.

The following illustration shows a custom menu.

Objectives

After completing this lesson, you will be able to:

■  Describe custom menus. 
■  Identify various options for customizing menus. 
■  Customize menus. 
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About Custom Menus

You customize menus to easily access frequently used commands, settings, and modes. Custom 
menus are displayed on the menu bar at the top of the drawing area. You can create new custom 
menus or modify existing menus by using the Customize User Interface dialog box. 

Definition of Custom Menus

A custom menu is a collection of tools on the menu bar that you modify and customize according to 
your workspace requirements. Custom menus list groups of predefined and custom commands. 
Menus can contain custom command elements that execute commands or macros. 

The commands of a custom menu represent commands under the Command List pane of the 
Customize User Interface dialog box.

The following illustration shows a custom menu command in the Customize User Interface dialog box.

You cannot create a blank custom menu. You must assign at least one command element to the 
menu and save it before you exit the Customize User Interface dialog box.

 

  Command under the Command List pane   Image assigned to the command under 
the Button Image pane

  Command assigned to a custom menu   Properties of the command under the 
Properties pane
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Menu Properties

When you select a custom menu in the Customize User Interface dialog box, the Properties pane 
displays information about it. 

 

Option Description

Name Displays the name of the menu. The value in this field is displayed on the 
menu bar.

Description Displays the description for the menu. This is an optional field.

Aliases Indicates the menu alias. The value in this field can range from POP1 to POP499. 
POP1 through POP16 menus are automatically loaded when the CUI file is 
loaded. By default, new menu aliases are assigned on the basis of other menus 
defined in the CUI file.

Element ID Displays the unique ID of the menu. 

You can create custom menus with commands that have already been used in other interface 
elements, such as toolbars.
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Example of Custom Menus

The following illustration shows three custom commands assigned to a custom menu.

Menu Customization Options

Menu customization options in the Customize User Interface dialog box enable you to create custom 
menus and modify existing menus. You use the menu options to create, organize, copy, and modify 
menus, as required. You can also create submenus by using the menu customization options.  

Access

 

  

Customize User Interface

Command Line:  CUI

Menu:  Tools > Customize > Interface

Menu:  Tools > Workspaces > Customize

Toolbar:  Right-click any button > Customize

Toolbar:  Workspaces (List) > Customize

Dashboard:  Right-click any button > Customize Commands
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Menu Customization Options

The following options are displayed when you right-click a menu under the Customizations in 
All CUI Files pane in the Customize User Interface dialog box.

 

Option Description

Insert Separator Places a separator element between the currently selected command and the 
subsequent command on a menu.

NOTE:  A separator is a blank interface element that appears as a line between 
commands on a menu.

New Menu Creates a blank menu. The new menu appears at the bottom of the menu list under 
the Customizations in All CUI Files pane.

New Sub-menu Creates a blank submenu within the selected menu and locates it at the bottom of 
the selected menu. 

Rename Renames the currently selected element.

Delete Deletes the currently selected element.

Duplicate Creates a duplicate copy of the selected element under the currently active node.

Copy Creates a copy of the currently selected element.

Paste Pastes the copied element.

Find Displays the Find and Replace dialog box, which can be used to search the user 
interface elements for specific words.

Replace Displays the Find and Replace dialog box, which can be used to search and replace 
specific text within the user interface elements.
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Customizing Menus

You can create new menus and customize existing menus by rearranging and adding standard 
commands and creating new commands. You use the Customize User Interface dialog box to create 
all the elements required for a custom menu. 

NOTE:  When you create a new menu, it is added to all the workspaces. You can remove the menu from 
some workspaces depending on the number of workspaces that you use.

Procedure:  Customizing Menus

The following steps describe how to customize menus.

1. Open the Customize User Interface dialog box and create a new command. 

  

2. In the Customize User Interface dialog box, Customizations in All CUI Files pane, create 
a new menu.

  

NOTE:  For creating a submenu, right-click the menu on which you want to create the submenu 
and click New Sub-menu.
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3. Under the Command List pane, click the command that you want to add to the custom menu 
and drag it onto the menu under the Customizations in All CUI Files pane.

  

TIP:  You can select multiple commands and drag them onto the menu by using the standard 
Windows® multiple selection keys, SHIFT and CTRL.

4. Under the Customizations in All CUI Files pane, click the current workspace to display the 
Workspace Contents pane. Click Customize Workspace.

  

5. Under the Workspace Contents pane, expand the Menus node and adjust the position of the 
new menu in the list.
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6. Ensure that the custom menu is working.
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Exercise:  Create a Custom Menu

In this exercise, you create a custom menu that 
contains a custom macro to create a rectangle.

To meet the design requirements of your project, 
you frequently need to create a rectangle that 
represents a standard cement slab. To automate the 
creation of the slab and to streamline your project, 
you create a custom menu that uses the rectangle 
command.

Prerequisite

Before taking this exercise, you should have created 
your main and enterprise customization files in the 
Prepare the Software for Customization exercise. 
To complete the Prepare the Software for 
Customization exercise, in the onscreen list of 
chapters and exercises, click Chapter 1: Customizing 
AutoCAD. Click Exercise: Prepare the Software for 
Customization.

The completed exercise 

Completing the Exercise
To complete the exercise, follow the 
steps in this book or in the onscreen 
exercise. In the onscreen list of 
chapters and exercises, click Chapter 1: 
Customizing AutoCAD. Click Exercise: 
Create a Custom Menu.

1. Open c_customize_menus.dwg.

2. Right-click a dashboard control panel. Click 
Customize Commands.

3. In the Customize User Interface dialog box, 
Command List pane, click Create a New 
Command. 

4. Under the Properties pane:

■ For Name, enter 500x250-Rectangle.
■ For Description, enter Creates a 500mm 

x 250mm rectangle.
■ For Macro, enter

^C^C^C_rectangle;\d;500;250;\.

  

5. Under the Customizations in All CUI Files 
pane: 

■ Right-click Menus. Click New Menu.
■ For the menu name, enter Custom.
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6. Under the Command List pane:

■ Select Custom Commands from the 
list (1).

■ Locate the 500x250-Rectangle 
command (2).

■ Drag the 500x250-Rectangle command 
to the Custom menu (3).

  

7. Under the Customizations in All CUI Files 
pane: 

■ Ensure that the Workspaces node is 
expanded.

■ Click the My Customized (current) 
workspace.

8. Under the Workspace Contents pane:

■ Expand Menus.
■ Locate the Custom menu.
■ Drag it above the Help menu.

  

NOTE:  New menus are automatically added 
to the current workspace.

9. Click OK to close the Customize User 
Interface dialog box.

10. In the drawing:

■ Click the Custom menu.
■ Point to the 500x250-Rectangle 

command.
■ Notice the description for the custom 

command in the lower-left corner of the 
drawing area.

  

11. Click Custom menu > 500x250-Rectangle.
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12. In the drawing:

■ At the Specify First Corner Point prompt, 
click the center of the point object by 
using the Node object snap.

■ At the Specify Other Corner Point 
prompt, click to the right of the point 
object to position the rectangle, as 
shown.

  

13. Close all files without saving.
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Lesson:  Migrating Customization Files

Overview

This lesson describes how to migrate customization files. You can transfer custom menus, toolbars, 
dashboard panels, profiles, lines, and hatch patterns from a previous version of the software to the 
current software version. You can also transfer customization information between installations of the 
same software version.

A typical software installation contains various files and settings that you customize according to your 
specific needs. These customization settings are stored in many types of files, including CUI, files, or 
other types of files when migrating from a much older installation. You migrate customization files 
from a previous software version so that you don’t have to recreate those files and settings on a new 
installation. You can also migrate files between installations of the same version. This is also an 
efficient means of distributing customizations between computers.

Various customization tools simplify the process of migrating customization files and settings to the 
current version of the software.

The following illustration shows the Migrate From a Previous Release tool being used to import 
customization files and settings from a previous version of the software.

Objectives

After completing this lesson, you will be able to:

■  Identify various options of the Migrate from a Previous Release tool. 
■  Identify various options of the Export and Import AutoCAD Settings tools. 
■  Describe the options on the Transfer tab of the Customize User Interface dialog box. 
■  Migrate custom toolbars. 
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About the Migrate From a Previous Release Tool

You use the Migrate From a Previous Release tool to transfer customization settings from a previous 
software release to the current version of the software. You can also use the Migrate From a Previous 
Release tool to move customization settings from the main CUI file to partial CUI files, or from a partial 
CUI file to another partial CUI file. 

The Migrate From a Previous Release tool is automatically started when a previous version of the 
software is detected on your computer during installation and you start the new version of the 
software for the first time.

When you migrate customization settings by using the Migrate From a Previous Release tool, the 
relevant information for interface elements is also transferred. For example, if you transfer a toolbar, 
which references another toolbar, the referenced toolbar is also transferred.

Access

A partial CUI file is a customization file that is not defined as the main or enterprise 
customization file. You can load and unload partial CUI files according to your requirements 
during a drawing session.

You must close the active AutoCAD sessions before starting the Migrate From a Previous Release 
tool. The tool does not open if the software is running.

  

Migrate From a Previous Release

Start menu (Windows) > (All) Programs > Autodesk > AutoCAD 2008 > 

Migrate Custom Settings > Migrate From a Previous Release
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Migrate From a Previous Release Tool

The following illustration shows the Migrate Custom Settings tool.

Migration Log File

When you migrate customization files and settings, a log file of migration results is created. This log 
file enables you to troubleshoot unwanted or unexpected results in your software profiles. The 
log file is stored in Documents and Settings\user profile\Application Data\Autodesk\AutoCAD 2008\ 
R17.1\enu\Migration.

 

  Migrate Settings 

From

Specifies the software version of the CUI files which need to be 
migrated.

  Settings and Files 

to Migrate

Specifies the files and settings that need to be migrated.

The Migrate From a Previous Release tool enables you to migrate custom menus or toolbars. 
More control over the migration of toolbars and menus is available by using the CUIIMPORT 
command.
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Key Points

■ The Migrate From a Previous Release tool is automatically displayed when a previous version of 
the software is detected on your computer during installation and you start the new version of the 
software for the first time.

■ The migration log file enables you to troubleshoot unwanted or unexpected results in your 
software profiles.

■ The log file is stored in Documents and Settings\user profile\Application Data\Autodesk\AutoCAD 
2008\R17.1\enu\Migration.

■ The Migrate From a Previous Release tool enables you to migrate custom menus or toolbars. 
The CUIIMPORT command gives you more control over the migration of toolbars and menus.

Export and Import AutoCAD Settings Tools

You use the Export and Import AutoCAD Settings tools to transfer files that contain configuration 
settings from one computer to another. You use these tools to migrate customization settings when 
the software version installed on both the computers is identical.

The Export and Import AutoCAD Settings tools enable you to maintain standard interface settings 
within an organization. These tools also increase the speed of the initial setup after you install 
the software.

Migration File

A migration file is a package that contains a group of customization components, such as registry 
settings, files extension maps, network file locations, profiles, and paths. Migration files have a .zip 
extension. You cannot transfer migration packages between different products or between different 
releases of the same product.

Access

You need to launch the software at least once before you can use the Export or Import 
AutoCAD Settings tools.

  

Export AutoCAD Settings

Start menu (Windows) > (All) Programs > Autodesk > AutoCAD 2008 > 

Migrate Custom Settings > Export AutoCAD Settings
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Export Custom Settings Dialog Box

The following illustration shows the Export Custom Settings dialog box.

Export Confirmation Dialog Box

After a migration file is successfully exported, the Export Confirmation message is displayed.

 

  Include Custom Files from 

Networked Locations

Includes custom files from networked locations. When this 
option is turned off, only custom files from the local computer 
are included in the migration package. 

  Export Exports the specified file.

  Cancel Closes the tool without exporting.

  Help Launches the software Help.

After you export custom settings files, the standard file navigation dialog box opens 
to the My Documents folder by default. The default name of the migration package is 
<PRODUCT><VERSION>_cust_settings.zip.

Export Confirmation message
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Access

Import Custom Settings Dialog Box

The following illustration shows the Import Custom Settings dialog box.

Import Confirmation Dialog Box

After you successfully import a migration package, the Import Confirmation dialog box is displayed. 
The following illustration shows the Import Confirmation dialog box.

  

Import AutoCAD Settings

Start menu (Windows) > (All) Programs > Autodesk > AutoCAD 2008 > 

Migrate Custom Settings > Import AutoCAD Settings

 

 

  Display Log File 

After Closing This 

Dialog

Displays a log file which contains information about the imported file 
such as warnings and error messages. When this option is turned off, 
the log is not displayed.

  OK Applies the changes and closes the Import Custom Settings 
dialog box.
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About the Customize User Interface Dialog Box

The software versions prior to AutoCAD 2006 stored menu and toolbar settings in MNU and MNS files. 
This information is now stored in an XML-based CUI file. The XML file offers greater portability and 
seamless migration to future releases.

To use menus and toolbars from an older version of the software, you need to convert the MNU and 
MNS files to the CUI file format.

You use the Transfer tab of the Customize User Interface dialog box to transfer customization settings.

Access

  

Customize User Interface dialog box—Transfer tab

Command Line:  CUIIMPORT

Command Line:  CUI > Transfer tab

Menu:  Tools > Customize > Import Customizations

Menu:  Tools > Customize > Interface > Transfer tab

Menu:  Tools > Workspaces > Customize > Transfer tab

Toolbar:  Right-click any button > Customize > Transfer tab

Toolbar:  Workspaces (List) > Customize > Transfer tab

Dashboard:  Right-click any panel > Customize Commands > Transfer tab

Both the CUI and CUIIMPORT commands launch the Customize User Interface dialog box. 
If you use the CUI command, the dialog box opens with the Customize tab selected and when 
you click the Transfer tab, the main CUI file is displayed under the left pane. However, if you 
use the CUIIMPORT command, the dialog box opens with the Transfer tab selected and the 
main CUI file is displayed under the right pane.
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Customize User Interface Dialog Box

The following illustration shows the Transfer tab of the Customize User Interface dialog box. You can 
use either of the two panes to import the MNU or MNS file and the opposite pane to transfer the 
customization elements. The method for importing customization files is the same regardless of the 
pane of the dialog box under which the main customization file is displayed.

 

  Customizations in New CUI File Displays the customization file being imported.

  Customizations in <file name> Displays the currently loaded CUI file.

  Open Customization File Enables you to specify a customization file to 
import.

NOTE:  If you select a file type other than CUI, the 
file type is converted to the CUI format.

  Drop-down list Enables you to switch to a currently loaded 
customization file, to which you can migrate the 
imported customization settings.

  Create a New Customization File Creates a new CUI file.

  Open Customization File Opens an existing CUI file.

  Save the Current Customization File Saves the current CUI file.
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Migrating Custom Toolbars

When upgrading the software version on your computer, you can migrate your customization files so 
that you retain and transfer your existing customization settings form the old version to the current 
version of software.

Procedure:  Migrating Custom Toolbars

The following steps describe how to migrate custom toolbars from an older version of the software to 
the current version.

1. Click Tools menu > Customize > Import Customizations. 

  

2. In the Customize User Interface dialog box, click the Open icon under the left pane to specify 
the customization file to import.
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3. In the Open dialog box, select Menu Files from the Files of Type list and specify the file that you 
want to convert to the CUI format.

  

4. Transfer the elements of the imported file to an existing CUI file by dragging the elements from 
the left pane to the appropriate category under the right pane.

  

NOTE:  You can also load a MNU or MNS file as a partial CUI file instead of transferring its 
contents to the main CUI file. To do this, right-click the Partial CUI Files node on the Customize 
tab and click Load Partial Customization File.
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Exercise:  Migrate a Custom Toolbar

In this exercise, you migrate a customized version of the Modify toolbar. The custom toolbar was created in 
the previous version of the software.

You have updated your computer with the current version of the software. You now need to migrate a custom 
toolbar from the previous software version to the current version.

The completed exercise 

Completing the Exercise
To complete the exercise, follow the 
steps in this book or in the onscreen 
exercise. In the onscreen list of 
chapters and exercises, click Chapter 1: 
Customizing AutoCAD. Click Exercise: 
Migrate a Custom Toolbar.

1. Create a new drawing.

2. Click Tools menu > Customize > Import 
Customizations.

3. In the Customize User Interface dialog box, 
Customizations in New CUI File pane, click 
Open.

4. In the Open dialog box:

■ Select Menu Files from the Files of 
Type list.

■ Navigate to the folder containing the 
exercise files.

■ Click MyCustom.mns.
■ Click Open.

5. Under the Customizations in Mycustom.cui 
pane:

■ Expand Toolbars.
■ Ensure that the MyCustom-Modify 

toolbar is displayed.
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6. In the Customize User Interface dialog box:

■ Ensure that the Toolbars category under 
the tree views of both the left and right 
panes is expanded.

■ From the left pane, drag the MyCustom-
Modify toolbar into the Toolbars 
category under the right pane.

  

7. Click OK to close the Customize User 
Interface dialog box.

8. Ensure that the migrated MyCustom-Modify 
toolbar appears in the drawing area, as 
shown.

  

9. Close all files without saving.
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Chapter Summary

Having learned this chapter, you can make simple customizations to interface elements, such as 
toolbars, menus, workspaces, and dashboards. While these methods can be considered simple, they 
are also very powerful and can lead to significant increases in productivity. 

Having completed this chapter, you can:

■ Use workspaces to change interface configurations. 
■ Create and manage macros and keyboard shortcuts by using the Customize User Interface 

dialog box. 
■ Describe, create, and manage custom toolbars by using the Customize User Interface dialog box. 
■ Describe and create custom dashboard panels. 
■ Use double-click actions to customize the behavior of the software when specific types of objects 

are double-clicked. 
■ Create custom menus by using the Customize User Interface dialog box. 
■ Migrate customization files. 
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